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1 Introduction

3dsMax (formerly 3D Studio Max) is a software package from Autodesk for modelling,
rendering and animation. The program is large and complex and presents a challenge
for beginners. This lab series is aimed as a guidance to explain the basics about how to
work with the program. 3dsMax contains tools to perform the following tasks:

1. Modeling objects in 3D.

2. Create materials and textures and apply them to the surface of objects.

3. Illumination of the created scene.

4. Rendering of the three-dimensional models with applied materials and lighting,
meaning that the scene is ”photographed” from the position of the virtual camera.

5. Animation of the three-dimensional models, i.e. setting them in motion.

6. Import of 2-D and 3-D models created with other design and CAD software.

7. Export of models for further use in other software.

8. Some limited post-processing of images and video.

2 Help

Note that there is lots of professionally produced and well written content for help and
support in 3dsMax, accessible through the Help menu. Please use that resource as your
first option when you need help and information on the program. YouTube and random
Google searches might be useful alternatives sometimes, but a lot of what you find out
there will be old and stale, and scaringly often it’s pure garbage. You should ask yourself
if it’s ”easier” to watch a ten minute video of dubious quality that possibly shows you how
to do than to read a most certainly relevant section in the searchable and well illustrated
written documentation. In short: Use the built-in help system of the program.

3 Starting the program, the main window

Translation of this section is incomplete for now. Section 4, Assignments,
is translated in full, though.

To start the program, click the desktop shortcut named Autodesk 3dsMax 2017 (En-
glish). If the shortcut isn’t there, you can find the program in the Start menu in the folder
Autodesk. After starting the program, you might get a few questions about how it should
look and behave. Pick the first (default) alternative for any such questions. After startup,
you are presented with a window according to Figure 1. The window consists mainly of
nine work surfaces. which we will cover briefly in the following. For a more thorough and
detailed description, please refer to the built-in help and the official tutorials.
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Figure 1: 3dsMax main window at startup

This view with four viewports makes the 3-D structure of the scene clear, but if you
are short on screen space or want to focus on one particular viewport, you can click the
small plus sign at the top left of any of the viewports (red circle in the figure below) and
pick Maximize viewport, or press Alt-W. To return to four views, pick Restore viewport in
the same menu, or press Alt-W once more. If you started in a mode where the program
shows the Scene Explorer, a panel to the left of the 3-D views that shows a list of all
objects in the scene, you can close it to get more screen space. That panel is nice when
you work with large scenes with many objects, but it’s not all that useful for the simple
scenes we will create in these introductory exercises. To show and hide Scene Explorer
there is a button Toggle Scene Explorer in the toolbar at the top (indicated by a yellow
circle in Figure 1).

3.1 Menus

The menus at the top are common Windows menus with a number of different commands
and sub-commands in several levels. Most of what is available in the menus is also in
several other places in the user interface, and in some cases also as keyboard short-cuts.
The menus are usually not the most convenient way of accessing a particular function,
but it’s a matter of taste which you prefer.

3.2 Toolbar

Toolbar is the collection of buttons just below the menu bar. Here you will find the tools
that are used most often. Contrary to many other Windows applications, some of these
tools are available only from the Toolbar and not from the menus. Most of the tools are
presented below. Some of the terms are explained later, and a few are left unexplained.
Complete information, if you need it, is in the Help system.
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3.2.1 Undo, Redo

These work like in any other program. You can take back an action, and then change
your mind about taking it back. Undo is as usual accessible through Ctrl-Z, and Redo
is on Ctrl-Y. However, there is an extra feature: you may right click on the buttons and
pick from a list how many steps you want to undo. This means that you can undo several
edits at once without clicking like crazy on the buttons. Several buttons have this logic
about right clicking, clicking on a certain spot or holding the mouse button down for a
while to see alternative functions, so consider taking a look on what other functions are
hiding beneath the other buttons presented below.

3.2.2 Select and Link

You may define a hierarchical relation between two objects by linking them as ”child”
and ”parent”. Link two objects by clicking this button and then dragging with the
mouse from the selected object (child) to another object (parent). You may also link
groups of objects, making the entire group the parent or the child in the relation. A
child inherits the transformations (translation, rotation, scaling) done to the parent,
but transformations done to the child will not have an impact on the parent. These
hierarchical transformations are fundamental to 3-D graphics when you work with larger
scenes and more complicated objects.

3.2.3 Unlink Selection

You may remove the hierarchical relation between two objects by forst selecting the
child object you want to unlink, and then press this button.

3.2.4 Bind to Space Warp

You can bind an object to a Space Warp by selecting the object, clicking this button
and dragging from the object to the Space Warp. Space Warps are used to deform and
animate objects, and they are covered in more detail in the Help system.

3.2.5 Selection Filters List
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Use this to determine which types of objects you want to be able to select with the
selection tools. Because many objects overlap on the screen, it’s sometimes easy to point
to the wrong object or get extra unwanted objects into the selection. In this case, selection
filters may help.

3.2.6 Select Object

Select objects by clicking first on this button and then on the object or objects you
want to select. To select more than one object, press the ctrl key for each object beyond
the first. To deselect an object, hold the alt key and click.

3.2.7 Rectangular Selection Region

Select one or more objects by clicking this button and then dragging a rectangle that
intersects or encloses what you want to select.

3.2.8 Window/Crossing Toggle

When selecting a region by dragging, the program can either select the objects that
are completely within the region, or those that are merely intersected by it. Which option
to use is determined by this setting. Window means that objects are selected only if they
are completely covered by the region, while Crossing will select objects that are merely
touched by the region.

3.2.9 Select by Name

Select one or more objects by picking their names from the list that pops up when
you press this button. In a large scene, it is often diffoult to click on the correct object
in the viewport, so this list is pretty useful. Of course, to make it useful you need to give
meaningful names to your objects. Keep this in mind!

3.2.10 Select and Move

Du kan flytta de markerade objekten med denna knapp. Det dyker upp en s.k. gizmo
som du kan dra i för att flytta objekten. Det finns olika omr̊aden p̊a denna som väljer
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hur du ska flytta saker och ting. Om du tar tag i pilen p̊a en enskild axel (x, y eller
z) s̊a flyttar du enbart längs den axeln. Om du tar tag i n̊agon av de tre små rutorna
som dyker upp vid basen p̊a axlarna när du kommer dit med musen s̊a flyttar du i det
planet. Om du till exempel tar tag i planet som är mellan axeln x och y s̊a kommer du
att kunna flytta objektet i x/y-planet. Rotate och scale har liknande gizmos. För en
ing̊aende förklaring av dessa hänvisas till hjälpsystemet. Du kan naturligtvis ocks̊a pröva
dig fram.

Om du vill skapa en kopia av ett objekt kan du h̊alla ner shift-tangenten medan du
flyttar det. D̊a skapas en eller flera kopior i stället för att du flyttar p̊a originalet.

3.2.11 Select and Rotate

Du kan rotera de markerade objekten med denna knapp. Eftersom rotationer i 3D
kan ske runt olika axlar s̊a f̊ar du välja axel genom att peka p̊a rätt ställe p̊a den gizmo
som dyker upp.

3.2.12 Select and Uniform Scale

Du kan skala (ändra storlek p̊a) objekt genom att klicka p̊a den här knappen, välja
objekt och skala objekten genom att klicka och dra med musen p̊a den gizmo som dyker
upp.

3.2.13 Select and Place

Den här knappen gör att objekt som flyttas försöker hitta ett sätt att lägga sig p̊a ytan
av andra närliggande objekt, vilket är praktiskt när man placerar ut objekt p̊a ojämna,
lutande eller krökta ytor.

3.2.14 Reference Coordinate System

Du kan ange vilket koordinatsystem som skall användas för transformationer (flyt-
tning, rotation, skalning). Det är ofta praktiskt att kunna transformera ett objekt i sitt
eget, lokala koordinatsystem, eller till och med i n̊agot annat objekts koordinatsystem, i
stället för att alltid använda scenens koordinatriktningar.
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3.2.15 Use Pivot Point Center

Det här är en lista med tre val som bestämmer runt vilken punkt som rotationer och
skalning skall genomföras. Pivot point center roterar varje objekt kring sitt eget origo. Se-
lection center roterar den aktuella markeringen kring de ing̊aende objektens gemensamma
medelpunkt. Transform coordinate center roterar kring det aktuella koordinatsystemets
origo.

3.2.16 Select and manipulate

Den här knappen gör att du visuellt och direkt kan ändra vissa inställningar för vissa
speciella objekt, manipulators. För mer detaljer om detta hänvisas till hjälpsystemet.

3.2.17 Keyboard Shortcut Override Toggle

Med hjälp av denna knapp väljer man mellan att använda de vanligaste kortkomman-
dona (tangentbordstryckningar som ersätter vanliga menyval och knappar i gränssnitter)
eller att dessutom använda kortkommandon för vissa särskilda redigeringsverktyg i pro-
grammet. Kortkommandon är bra att ha om man vill jobba snabbt och effektivt i pro-
grammet, men de är inte nödvändiga. För detaljer om detta, se hjälpsystemet.

3.2.18 3D Snap Toggle

Denna knapp är till för att l̊asa det du skapar och flyttar p̊a mot ett koordinatsystem
som du bestämmer. Hjälpen förklarar hur den fungerar. Den kan dels l̊asa mot koordi-
natsystemet p̊a skärmen, men ocks̊a mot linjer, punkter och ytor i scenen. Det här är ett
n̊agot komplicerat men mycket användbart verktyg som kan underlätta modellering och
placering av objekt i en stor scen.

3.2.19 Angle Snap Toggle

Du kan l̊asa rotationer till vissa bestämda gradtal när du roterar genom att trycka in
denna knapp. För att ändra vilka steg den l̊aser till, högerklicka p̊a knappen för att f̊a
upp en ruta med inställningar.
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3.2.20 Percent Snap Toggle

När du ändrar saker som anges i procent, till exempel när du skalar objekt, s̊a kan du
använda denna för att l̊asa till fasta steg. Högerklicka för att ange stegets storlek.

3.2.21 Spinner Snap Toggle

Spinners är värdeangivelser i textrutor med upp- och nedpilar intill sig. S̊adana finns
i stort sett överallt i gränssnittet. Här här kan du ställa in olika stora steg när du ändrar
p̊a spinners, till exempel när du ändrar storleken p̊a en sfär som du precis skapat.

3.2.22 Edit Named Selection Sets, Named Selection Sets

Du kan välja en uppsättning objekt och ge dem ett gemensamt namn, för att enkelt
kunna välja dem igen. Det här är inte samma sak som att gruppera objekten, eftersom
Named Selection Set inte l̊aser deras position gentemot varandra. Först markerar du de
objekt du vill ska ing̊a i mängden, och sedan skriver du mängdens namn i rutan och
trycker Return. Du kan sedan markera samma urval när du vill genom att klicka p̊a
mängdens namn. En klok användning av lager (layers), grupper (groups) och s̊adan här
selection sets är nästan oumbärligt när man börjar modellera mer komplicerade objekt
och scener. Det är annars väldigt lätt att g̊a vilse i en ostrukturerad soppa av ogrupperade
objekt som har illa valda, intetsägande namn som t ex ”Box093”.

3.2.23 Mirror

Du kan spegelvända ett eller flera valda objekt. När du klickar p̊a denna knapp öppnas
ett fönster där du kan ändra inställningarna och se resultatet av dina ändringar i vyerna.

3.2.24 Align

Align öppnar en egen dialogruta som inneh̊aller verktyg för att rikta in och placera ob-
jekt i förh̊allande till andra objekt i scenen, eller i förh̊allande till kameror. Det finns flera
andra underfunktioner p̊a den här knappen, men för en fullständig genomg̊ang hänvisar
vi till programmets inbyggda hjälpsystem.
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3.2.25 Toggle Scene Explorer

Öppnar och stänger en lista över alla objekt där man kan välja dem p̊a namn i stället
för att peka p̊a dem i scenen. Mycket användbart för stora scener. Kräver att objekten
getts n̊agorlunda beskrivande namn. Scene Explorer kan dockas fast p̊a endera sidan om
dina viewports om du vill ha den uppe för jämnan.

3.2.26 Toggle Layer Explorer

Öppnar en editor för att hantera lager. Lager är ett sätt att strukturera en stor scen
i löst grupperade delar som p̊a n̊agot sätt har med varandra att göra, ungefär som det
fungerar i de flesta 2D-ritprogram. Lager har inget med ”över” och ”under” att göra som
det har i 2D-sammanhang, men ett lager kan visas och gömmas som en enhet. Layer
Explorer kan dockas in bland dina viewports om du vill ha den tillgänglig hela tiden.

3.2.27 Toggle Ribbon

Denna knapp aktiverar en rad med knappar och ikoner som ligger under den huvusak-
liga toolbar. Där finns samlingar med verktyg som är specialdesignade t ex för att utföra
olika slags modellering. ”Ribbon” är ett dynamiskt verktygsfält i stil med vad som finns
i vissa andra Windows-program, och som man själv kan modifiera för att passa ens egna
behov. Vi kommer inte att g̊a in p̊a detta närmare, men det är ett smidigt sätt att effek-
tivisera arbetet om man märker att man ofta upprepar samma handgrepp i programmet
och de känns kr̊angliga, till exempel för att funktionerna ligger l̊angt ifr̊an varandra i
gränssnittet.

3.2.28 Curve Editor

Inneh̊aller de verktyg som behövs för att jobba med Tracks och Function Curves i
animering. (I tidigare versioner av programmet öppnades den kompaktare vyn Dope
Sheet, men numera används Function Curves som standardvy. Den gamla vyn med
endast keyframes finns som alternativ i menyn ”Editor → Dope Sheet” när man öppnat
Curve Editor.)

3.2.29 Schematic view

10



Här finner du en editor och vy för hur dina objekt förh̊aller sig till varandra och vilka
material de har. Det är en schematisk översikt över hela din scen. Tyvärr är den inte s̊a
översk̊adlig, men den kan vara bra att ha i vissa fall. Många andra 3D-program har en
bättre schematisk vy, som d̊a ocks̊a är mer central för hur man jobbar i programmet.

3.2.30 Material Editor

Inneh̊aller funktioner för att skapa och redigera materials och maps. Detta behandlas
utförligare i laboration 2.

3.2.31 Render Setup, Rendered Frame Window, Render Production

Dessa knappar har med renderingen att göra, allts̊a den del av programmet som räknar
ut en bild av din scen, med hänsyn taget till ljussättning, skuggor och alla material.
Rendering behandlas litet närmare i laboration 3. Det finns en uppsjö av inställningar
för att styra renderingen, varav de vanligaste sitter direkt p̊a renderingsfönstret. De flesta
innebär n̊agot slags kompromiss mellan realism och hastighet. Bra bilder tar oftast l̊ang
tid att rendera. Snabba renderingar blir sällan snygga.

3.2.32 Render in the Cloud, Open Autodesk A360 Gallery

De här knapparna har att göra med Autodesks ”cloud rendering”, en kommersiell
tjänst som gör att man kan rendera p̊a deras datorer p̊a nätet i stället för att behöva
investera i egna datorresurser. Kostnadsfria studentlicenser och rabatterade licenser för
utbildningsbruk har inte tillg̊ang till denna tjänst.
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3.3 Command Panel

För att skapa och redigera objekt används Command Panel, den breda vertikala panelen
längst till höger. Det finns sex olika knappar överst i Command Panel :

3.3.1 Create

Det finns sju olika knappar överst p̊a Create Panel för att skapa olika saker: Geometry
(3D-objekt, t.ex. box, sfär, kon), Shapes (2D-objekt, t.ex. linje, cirkel, ellips), Lights
(ljuskällor), Cameras (kameror för att bestämma vyn för rendering), Helper (för att t
ex skapa stödlinjer), Space Warp (för att exempelvis tänja och deformera objekt) och
Systems. Varje avdelning har sedan i sin tur n̊agra olika underavdelningar. Bekanta dig
gärna litet närmare med vad som finns genom att bläddra runt i panelen, och se vilka
varianter man kan välja.

3.3.2 Modify

Används för att modifiera det markerade objektet. Objektets namn visas överst p̊a
panelen och under det visas en samling av tillgängliga Object Modifiers. Modifiers lägger
sig p̊a en modifier stack, som syns under Modify-fliken. Modifier -stacken är mycket central
när man gör modellering och animering i 3DSMax, och många andra 3D-program fungerar
p̊a liknande sätt.

3.3.3 Hierarchy

Används för att jobba med funktioner relaterade till hierarkiskt länkade objekt, ex-
empelvis att flytta p̊a deras lokala origo (pivot point).

3.3.4 Motion

Ger tillg̊ang till de verktyg som anpassar det markerade objektets rörelse i ani-
meringar.

3.3.5 Display
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Kontrollerar hur objekt visas i vyerna (Viewports). Man kan exempelvis välja att
gömma ett objekt för att göra scenen mindre plottrig medan man jobbar, eller visa vissa
särskilt komplicerade objekt som enkla boxar för att snabba upp och förenkla arbetet
med scenen.

3.3.6 Utilities

Inneh̊aller n̊agra allmänna extra funktioner som används i 3DSMax. Fler ”utilities”
kan definieras p̊a olika sätt, antingen genom ”plug-ins” som programmeras i C++ eller
med scriptprogrammering i ett inte s̊a himla bra men änd̊a ganska användbart program-
meringsspr̊ak som heter MaxScript, eller i det modernare spr̊aket Python. Detta ligger
dock l̊angt utanför ramen för dessa inledande laborationer.

3.4 Time Controls

Time Controls best̊ar av en bred time slider precis under vyerna (viewports) och
ovanst̊aende knapparna i panelen längst ner i fönstret. Här kan du skapa och redigera
animationer genom att sätta keyframes, keys, för olika egenskaper. Man kan animera i
stort sett vilka egenskaper som helst hos objekt. Allt som kan ställas in med en spinner
g̊ar att animera. Förutom position och riktning för objekt kan man ändra exempelvis
färg och form.

Man kan animera med keyframes p̊a tv̊a olika sätt. Dels kan man använda Auto
key. D̊a flyttar man helt enkelt time slidern och flyttar och ändrar sina objekt fritt. D̊a
kommer det att sättas en keyframe s̊a snart när man ändrar n̊agot. I många fall är det
sv̊art att f̊a exakt det resultat man vill med denna metod, och det kan bli onödigt många
keyframes att h̊alla reda p̊a. D̊a kan man i stället trycka in Set Key s̊a kan man flytta,
rotera, skala och modifera objekten fritt. Det sätts en keyframe först när man trycker p̊a
den stora plus-knappen med en nyckel. Mer om detta finns att läsa i hjälpen.

Animationskontrollerna tas inte upp i detalj här. Vi återkommer till dem senare, i
laboration 4.

3.5 Vyer (Viewports)

De fyra stora fönstren som täcker den största delen av huvudfönstret är vyerna, View-
ports. De används för att titta p̊a scenen fr̊an olika vinklar. Fr̊an början (efter att man
återställt standardvyn med Restore viewports, se inledningen) ser man fyra lika stora
vyer. Längst ner till höger finns perspektiv-vyn som kan visa scenen fr̊an vilken vinkel
som helst. Övriga fönster visar ortografiska vyer, vilket betyder att du kan se scenen
parallellprojicerad (utan perspektiv) längs endera av x-, y och z-axlarna. Antalet vyer
och deras typ kan ändras. Ofta vill man i stället jobba med flera perspektivvyer, till
exempel kopplade till var sin kamera i scenen.
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Om du har en liten skärm med l̊ag upplösning, t ex en mindre laptop, s̊a kan det bli
väldigt tr̊angt om utrymme för att visa 3D-vyerna. Det blir bättre om du stänger alla
extra paneler som till exempel Scene Explorer (se inledningen), men det är fortfarande
sv̊art att jobba med 3dsMax om man har en skärm med l̊ag upplösning. Dels är det
många saker som ska f̊a plats i huvudfönstret, dels öppnas det en rad extra fönster för
olika ändamål. En HD-upplöst skärm är bra att ha, och det skadar inte att ha en ännu
större skärm, eller flera skärmar, när man jobbar med programmet.

3.5.1 Konfigurering av vyer

Vyernas typ och uppdelning kan ändras i vyns konfigurationsdialog. (Views → View-
port Configuration). En praktisk genväg är att högerklicka p̊a vyns beteckning i view-
porten(t ex Top). D̊a f̊ar du upp en meny där vyns inställningar kan ändras.

3.5.2 Aktivering av vyer

Modellering och animering kan göras i vilken vy som helst. Medan du redigerar ett objekt
i en vy uppdateras alla övriga vyer. Du kan manipulera objekten i perspektiv-vyn och
observera deras förändringar i de tre ortografiska vyerna, eller du kan manipulera dem i
varje ortografisk vy för att f̊a mer kontroll. Det är helt och h̊allet upp till dig hur du vill
jobba, men glöm inte bort de ortografiska vyerna. De kan vara väldigt praktiska och ger
ofta bättre koll p̊a läget än perspektivvyn. Den vy du jobbar i blir det aktiva fönstret,
och det finns bara en aktiv vy åt g̊angen. Den aktiva vyn är omsluten av en gul ram
(eller en röd ram om du har aktiverat animering). En vy aktiveras s̊a fort du högerklickar
inom den. Ett vänsterklick fungerar ocks̊a, men det kan innebära att samtidigt som du
aktiverar vyn markerar du även ett objekt inom vyn. Ta för vana att alltid högerklicka
för att byta vy.

3.6 Viewport Navigation Controls

De knappar som sitter längst ner till höger i huvudfönstret är navigationsknapparna
för vad du ser i dina vyer. Knapparna ändrar din vy av scenen, men p̊averkar inte
objekten. Undantaget är om du har en vy kopplad till en kamera - d̊a flyttar du p̊a
kameran med dessa kontroller.

3.6.1 Zoom

Du kan zooma in/ut i den aktiva vyn genom att välja detta verktyg och sedan klicka
och dra i vyn med musens vänsterknapp. Musens scrollhjul fungerar ocks̊a för detta
ändamål, men s̊a sker den stegvis i steg som man inte riktigt har kontroll över hur stora
de blir.
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3.6.2 Zoom All

Du kan zooma in/ut samtidigt i alla vyer.

3.6.3 Zoom Extents Selected

Du kan zooma vyn s̊a att ett eller flera objekt lagom täcker hela fönstret. Om du har
ett eller flera objekt valda s̊a zoomas det s̊a att just det eller de objekten visas bra i vyn.
Om inga objekt är valda zoomas det s̊a att alla objekt i scenen syns. Detta kan vara
bra om man t ex tappat bort sig i vyn och inte hittar tillbaka, eller om ett objekt r̊akat
hamna l̊angt bort fr̊an de andra av misstag s̊a att man inte ser det.

3.6.4 Zoom Extents All Selected

Du kan zooma alla fönster samtidigt p̊a samma sätt som i 3.6.3. Observera att detta
zoomar olika mycket i olika vyer, vilket kan vara förvirrande.

3.6.5 Field of View (FOV)

I perspektivfönstret är effekten av att ändra Field of View (FOV) densamma som att
ändra brännvidden p̊a linsen p̊a en kamera. Det är detta som egentligen kallas ”zoom”
inom fotografi. (Det 3DSMax kallar ”zoom” kallas egentligen ”dolly” av fotografer, efter-
som filmkameror åtminstone förr i tiden var tunga och därför alltid stod p̊a en vagn, en
”dolly”, som dessutom ofta gick p̊a räls.) Undvik att ändra FOV till alltför stora eller
små värden. Effekten blir konstig och orealistisk. De förinställda valen för objektiv med
olika brännvidder p̊a en kamera representerar vanliga och vettiga värden.

3.6.6 Pan

Du kan flytta vyn i sidled eller i höjdled i den riktning du flyttar musen. (I film-
sammanhang kallar man egentligen dessa rörelser för ”truck” i sidled och ”pedestal” i
höjdled. ”Pan” avser egentligen en rotation i sidled, och ”tilt” är när man vinklar kam-
eran i höjdled. 3dsmax är slarvigt med begreppen här. Men åter till saken.)

3.6.7 Orbit SubObject

Du kan rotera vyn med rotationscentrum i ett visst objekt. Kameran roterar p̊a ett
fast avst̊and fr̊an detta objekt, och riktas hela tiden mot det objektet.
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3.6.8 Maximize Viewport Toggle

Du kan maximera/minimera storleken p̊a den aktiva vyn. Det är ofta praktiskt
att arbeta i en mer detaljerad maximerad vy, s̊a att man ser tydligare vad man gör med
objektet man h̊aller p̊a att ändra. Snabbkommandot för detta är Alt-W. Detta är ett
av de f̊a snabbkommandon som det verkligen är praktiskt att kunna även när man är
nybörjare.
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4 Assignments

4.1 Creating a simple scene

In this section we will learn to create simple primitives like spheres, cylinders, boxes and
the like. If the program is not started fresh, start by making (File → Reset) in 3dsMax.
Then, activate the Perspective view by right clicking on its title.

1. In the Command Panel, pick Create → Geometry.

2. Click the button Sphere and start drawing directly in the perspective view.

3. Click the last word in the heading at the top of the current viewport, where it says
”Default shading”. Pick instead Wireframe Override or Edged Faces to clearly see
the polygon structure of the objects you create.

4. Click on the tab Modify, just right of Create.

5. Under Parameters in Modify, there are two settings, Radius and Segments. Try
them and see how they work. Reduce Segments to 4. What happens? Why change
this? Think about possible advantages of having few or many segments.

6. Now try creating a cylinder. Go back to Create → Cylinder.

7. Do like step 3 above and click the heading in the viewport to change the style of
the display. This time, pick Facets.

8. Select the cylinder.

9. Look at the tab Create, at the top where then name and the color of the object is
shown, change the name of the object from ”Cylinder01” to ”Cylinder” and change
it to a suitable color by clicking on the color indicator (the colored square). Pick a
light color for your objects, so they are clearly visible in the viewport.

10. Now, repeat step 7 but change Facets to Default rendering. What happens?

4.2 Modifying an object

Now, let’s try modifying an object and make a model that is not only built from primitives
in their basic form. We are going to create a coffee mug. Start by performing Reset in
3dsMax. Then activate the perspective view.

1. In the Command Panel, choose the tab Create → Geometry.

2. Pick Wireframe override for the rendering style in the viewport.
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3. Click Tube to create a tube.

4. Don’t point and click freehand style this time, but open the sub-menu Keyboard
Entry in the Command Panel.

5. Set Inner Radius to 39, Outer Radius to 43 And Height to 65. Press ”Create”, and
name the object ”wall”.

6. Now for the bottom. Choose Cylinder and create a cylinder with a suitable size for
the tube you just made. Name it ”bottom”. See Figure 2.

7. Activate the Top view, and select one of the objects.

8. Now click Align in the menu, in the Toolbar or by the short-cut Alt-A, and then click
the other object. A dialog window will pop up: Align Selection. First you selected
the object you want to move, then you used the Align command, and selected the
object you want to move in relation to. Current object is the first selected object,
and Target object is the obejct you selected after issuing the Align command. Check
the boxes X Position and Y Position. What happens? Try checking and unchecking
the other boxes and contemplate the difference. Change also between Center, Min
and Max for both objects until you understand how this works. The button Apply
moves the object but keeps the dialog open, so that you can make several different
Align operations in different directions without reopening the dialog several times.
The button OK performs the alignment and closes the dialog.

9. Pour some coffee into the mug, by creating another cylinder of suitable size and
placing it inside the mug with Align.

10. Now, let’s add a handle to the mug. In the Create panel, pick Box and draw a box.

11. Set Length to 10, Width to 4 and Height to 70. Also set Height Segs to 20.
You will soon see why. Name the object ”handle”.

12. Now start modifying the handle by picking Modify → Taper.

13. In Parameters, set Amount to 1 and Curve to –2.

14. Then add a second modifier Bend and set Angle to –180. Now, you can select Box
in the Modifier Stack. Change the number of Height Segs back to the default value
1. What happens? Why? Change it back to 20

15. Now that you created the handle, it’s time to attach it to the mug. This can
be performed with Align as well, similarly to above. You may have to tweak the
position manually to avoid a gap where the flat ends of the handle meets the rounded
mug, but start by using Align to center the handle.

16. The mug doesn’t look very appealing to drink from. In the Modify panel, increase
the number of Sides around your Tube until it looks round enough.

18



17. The mug is round now, but the upper rim looks like you would cut yourself on it.
Round it off by going to the Modify panel and add the modifer Chamfer. Study
what happens by showing the object in Wireframe Override mode or enabling Edged
Faces in the viewport. Most likely, the edges around the curved surface your mug
will be rounded off as well, which is not what we want. Increase Min Angle for your
Chamfer until only the crisp 90 degree angles are rounded off.

18. The chamfered edge is straight, which is not appropriate for this particular object.
To get a softer edge, change the setting for Chamfer by increasing Segments some-
what, reduce Tension to 0.5 and experiment with Amount until the edge is round
and nice.

19. The handle has too sharp edges as well. Round it off with the modifier MeshSmooth,
which is one of several methods in the program to create something called mesh
subdivision. To see more clearly what happens, uncheck the box Isoline Display in
the panel for MeshSmooth to see all the newly created polygons. Increase Iterations
to 2 if you want the handle even smoother. More than 2 is probably not necessary.
Beware of increasing Iterations too much, because it may create a very large amount
of polygons that require lots of time to compute and lots of memory to store. The
worst case is that the program stops responding or even crashes. Most computers
have problems handling a huge amount of polygons in the interactive viewports.

20. MeshSmooth and similar methods round off objects, but also make them slightly
smaller. If required, move the handle to reattach ot to the mug, and consider
increasing the size of the Box at the bottom of your modifier stack to make the
handle thicker again.

21. Don’t forget to save your work! Name the file mug.max or something similar.

Figure 2: The separate parts of a low resolution polygon model of a coffee mug.
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4.3 Making a banana

3-D modelling can be performed in many different ways, and you can save a lot of work
by finding the right tool for a certain job. You can also spend too much time looking
for the perfect tool, but note that there are hundreds of modelling tools and modifiers in
the program, and they are all there for a purpose, even though some of them are quite
specialized.

To make a banana, two convenient tools are Loft, to make the model, and Smooth, to
make it appear reasonably rounded. Loft objects are examples of so-called swept surfaces,
where 2-D Shapes are moved along Curves to trace out 3-D objects. Many real world
manufacturing processes make objects with that kind of shape, e.g. strand moulding and
profile cutting. You can read more about Loft in the Help section. We will now create
two Shapes according to Figure 3.

1. To create the line, start by drawing a straight line (CreateCreate → Shapes →
Line) in the Front view. You do this by first left-clicking somewhere in the view
to set the starting point. Then, move the mouse to the desired end point and click
again. Last, right click to end the line. The line is now selected. Then, go to the
Modify tab in the Command Panel, and click the little triangle to the left of the
word Line in the modifier stack, to access the Sub-object level. Click Vertex to
adjust individual vertex points. A small square appears at the endpoints of the
line. Right click on the starting point. In the menu that pops up, pick Bezier or

Bezier Corner. Move the green tangent point that appears with the Move tool
to change the curvature of the line. Repeat for the endpoint, and adjust until you
are happy with the result.

2. To create the hexagon, use the tool NGon. You will find it in Create → Shapes →
Spline → NGon.

20



Figure 3: Two Shapes which will eventually form a banana

Now, we will move the hexagon, the (Loft Object), along the line, the (Loft Path)
to create a surface:

3. Make sure you have the line selected, go to Create → Geometry. Select the sub-
section Compound Objects and click Loft.

4. Now click the button Get Shape and select the hexagon.

5. Our newly created object has the same thickness everywhere. To make it smoothly
tapered like a banana we will use Deformations at the bottom of the Modifypanel
for the Loft objektet. In Deformations, click Scale and arrange the points to create

a curve similar to the one in Figure 4. With the buttons and , you can
move a point and change the slope of the curve at that point. Use the tool Insert

Bezier Point to add more control points along the line. If you get a corner
where you want a smooth curve, or vice versa right click the point and select its
type: Corner, Béziér-smooth or Béziér-corner.
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Figure 4: Adjusting the profile of the banana by Deformations → Scale.

6. To make the edges of the banana smooth and rounded, you can of course use either
of the methods you used on the coffee mug above, but we choose to cheat and
only round off the normals, to create an appearance of roundness without actually
changing the shape of the banana. Select the banana, go to the Modify panel, and
in the list of all the modifiers, pick Smooth. Then click Auto Smooth. This is not
enough, though. You need to change the value for the largest angle to smooth,
(Threshold). Test setting that to around 60 degrees. Now, the normals will be
interpolated smoothly across the polygons that are closest to the edge, and the
banana will appear as if it had less sharp corners.

7. If you think the banana looks too blocky because of too few segments, you can
change the number of steps in the Loft object. Select the banana, look in the Modify
tab, open the sub-panel Skin Parameters and change the settings for Shape Steps
and Path Steps. Try also to check and uncheck the box Adaptive Path Steps. Find
a good balance where you think the object looks good without using an extreme
amount of polygons.

8. Don’t forget to save your object. Name the file something relevant, like banana.max.
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4.4 Extra assignment (Optional)

If you have the time, create something else! Feel free to experiment on your own, but
don’t forget the help which is available by pressing F1 or through Help → User Reference
in the menu. There is of course also a lot of online material, but we strongly recommend
the built-in help system of the program as a first hand reference. Itäs well written, correct,
detailed, well illustrated and generally of good quality, something that can’t generally be
said about most of the stuff you find on the Internet. Furthermore, online material from
other sources is often written for an older version of the software. 3dsMax and similar
programs are changing fairly rapidly, and every new version looks slightly different. Older
tutorials are often confusing, and sometimes not even applicable to the current version.
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